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About this manual1.

Copyrights1.1.

The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2006 ABB. All rights reserved.

Trademarks1.2.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General1.3.

This manual provides thorough information on the Station Computer COM615 and the
central concepts related to it. For more information on each topic related to a specific
protocol, refer to the list of related documents in 1.8, Related documents.

Information in this operator's guide is intended for operators who perform every-day
operations.

Use of symbols1.4.

This publication includes warning, caution, and information icons that point out safety
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.
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The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It might indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Document conventions1.5.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the

keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing

the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy

a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations:  MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:
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Entered value is not valid. The value must be 0 to 30.

• You may be told to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Terminology1.6.

The following is a list of terms associated with the Station Computer COM615 that you
should be familiar with. The list contains terms that are unique to ABB or have a usage
or definition that is different from standard industry usage.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

Part of a logical node object representing specific information,
e.g., status or measurement. From an object-oriented point of
view a data object is an instance of a class data object. DOs are
normally used as transaction objects; i.e., they are data struc-
tures.

Data Object; DO

A physical device that behaves as its own communication node
in the network, e.g. protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

A communication protocol developed by Echelon.LON

A proprietary method of ABB on top of the standard LON pro-
tocol.

LON Application Guideline for
substation automation; LAG

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Named data item.Property

ABB proprietary communication protocol used in substation
automation.

SPA
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Abbreviations1.7.

The following is a list of abbreviations associated with the Station Computer COM615
that you should be familiar with. See also 1.6, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Communication Engineering ToolCET

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Human Machine InterfaceHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

LON Application Guideline for substation automationLAG

Local Area NetworkLAN

Network Control CenterNCC

Single Line DiagramSLD

Related documents1.8.

MRS numberName of the manual

1MRS756125COM600 User’s Guide

Document history1.9.

HistoryProduct revisionDocument version/date

Document created3.0A/16.10.2006

Document revised3.0B/22.1.2007

Document revised3.0C/8.6.2007

Document revised3.1D/21.12.2007

Document revised3.2E/17.06.2008
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Introduction2.

Product overview2.1.

Station Computer COM615 acts both as an embedded communication gateway between
substation automation protection and control devices and Network Control Centers
(NCC), and allows easy access to the protection and control devices of a substation either
locally or remotely with the HMI functionality.

COM615 uses an embedded operating system and runs in a dedicated industrial computer
without moving parts.

The products are configured using a separate engineering PC that is connected via the
local area network (LAN). For more information, refer to COM600 User's Guide.

Gateway Functionality

The gateway functionality provides a framework that enables the use of OPC server and
client components, such as OPC Client for IEC 60870-5-101 and OPC Server for LON
LAG 1.4. For more information, refer to COM600 User's Guide.

HMI

The features of HMI include a Single Line Diagram, Busbar coloring, lists of events and
alarms, disturbance data upload, system supervision, control of breakers and switches,
parameter settings, measurement display, and user management. For more information,
refer to COM600 User's Guide.
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CET operations3.

Opening a project in CET3.1.

To open a project in CET:

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Expand the projects list, by clicking on the + symbol, to select the required project.
4. Click Open Project

Gateway management3.2.

The Gateway Management tool enables you to transfer the configurations of the objects
to the COM600 computer.

To be able to use the Gateway Management Tool, the engineering computer must be
connected to the COM600 computer. The IP address of the used ethernet port in the
COM600 computer must be entered to the corresponding Gateway object property. For
more information, see COM600 User's guide.

To open the Gateway Management tool, right-click the Gateway object in Communication
Engineering Tool (CET) and select Management.

• To copy the configurations of all servers and clients to the Gateway computer, click
Update configuration.

• To restart all servers and clients with the latest configurations, click Reload config-
uration.

• To transfer only the changed configurations and to restart only the changed server
or client with new configurations, click Update & reload configuration.

License handling3.3.

The Gateway Management tool displays the license information for COM600 under
License Information. The license and the protocols it supports have been predefined
before the COM600 computer has been handed over by ABB.

The following information is shown in the window:
• owner of the license
• product revision
• protocols supported by the license.
• number of servers supported by the license.
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• number of clients supported by the license.
• if WebHMI is enabled.

To update the license with a new set of protocols, order a new license from ABB and
update it to COM600 with Communication Engineering Tool.

To update the license:
1. Open the Gateway Management tool.
2. Click Update License.
3. Browse for the new license file and click Open.

The license is COM600 specific and the COM600 computer verifies the compatibility
of the license. Also the servers and clients verify the license.

Diagnostics3.4.

General about diagnostics3.4.1.

Communication Engineering Tool (CET) provides comprehensive functions for diagnos-
ing the operation of the Gateway. This includes communication diagnostics with monit-
oring the communication channel, diagnostic counters and IED specific communication
status and diagnostic counters. It is also possible to monitor and control process data and
follow the data flow on the Gateway using diagnostic functions of CET. Figure 3.4.1-1
displays a sample view of a diagnostic counter dialog. An example of an event log file
is displayed in Figure 3.4.1-2
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SPAChnlDiag.jpg

Figure 3.4.1-1 An example of a SPA channel diagnostic counter dialog

EventDial.jpg

Figure 3.4.1-2 An example of a SPA event log file
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Data object diagnostics3.4.2.

You can monitor and control the data objects under the Gateway’s object tree with Data
object diagnostics.

To monitor and control the data objects:
1. Right-click the Gateway.
2. Select Data object diagnostics from the shortcut menu, see Figure 3.4.2-1. The

Data object diagnostic dialog opens.
3. Drag and drop data objects from the object tree to the Data object diagnostics.

or

1. Select a specific data object from the object tree.
2. Select Tools > Online diagnostics.

DataObjDiagnos.jpg

Figure 3.4.2-1 Data object diagnostics

To change the value of a data object attribute:
1. Select a specific attribute.
2. Write a new value to the text box under the Write value button.
3. Click Write value to change the value.

To filter the displayed data object:
1. Click Excluded items.
2. Notepad opens. Write to Notepad the data object types you want to exclude from

the Data object diagnostics view.
3. Save the Notepad file by selecting File > Save.

Diagnostic services of OPC servers and clients3.4.3.

You can control and monitor the server and client channel and device communication
in the communication structure of the Project Explorer. You can take channels/subnet-
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works and devices into use or out of use via the respective diagnostics function. You
can also monitor the channel/subnetwork and device communication with the help of
various diagnostic counters, and check the device status information, see Figure 3.4.3-
1.

LONClockMaster.jpg

Figure 3.4.3-1 An example of LON Clock Master online diagnostics

For more detailed information and instructions on controlling and monitoring channel
and device communication, refer to the respective user’s guide for the client or server
(see 1.8, Related documents).

Signal diagnostics3.4.4.

OPC clients have a diagnostic function which makes it possible to monitor the flow of
process data changes and commands. Activate the function by marking the Diagnostic
Events Enabled check box, located in the Online diagnostics function of the
IEC101/IEC104 Device. When the diagnostic function is activated, the IEC101 OPC
Client Alarm & Event server generates events with information about data changes and
commands.
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IEC101AEClient.jpg

Figure 3.4.4-1 IEC101 Slave OPC Client Diagnostic AE client

Diagnostic Web Server3.4.5.

The Diagnostic Web Server of the Gateway provides an overall view of the communic-
ation status of the Gateway and the possibility to monitor the diagnostic counters of the
communication channels/subnetworks and IED communication. Figure 3.4.5-1 displays
the gateway objects in a tree view.

A red cross over the Gateway icon in the object tree indicates that there is a fault in the
communication structure. Expand the tree to view the hierarchy deeper and to identify
the device with a missing configuration or causing the error. The properties of a certain
object in the communication structure can be seen on the right when clicking on the
object in the tree view.
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Webserver_a.jpg

Figure 3.4.5-1 An example of a web page from the Gateway diagnostic web server
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HMI operations4.

General about HMI4.1.

The HMI interface consists of different views, a menu bar and a tool bar.

You can choose between views by clicking the tabs on the left:
• Substation: Shows the substation structure.
• Communication: Shows the communication structure.
• Users: (Only administrator) Shows the user information. The administrator can

manage users in this view.
• Settings: (If not administrator) Shows the user information. The user can change

the password in this view.

The Menu bar contains the following functions:
• General: Shows device information.
• Single Line Diagram: Shows the Single Line Diagram view.
• Events: Shows the events list.
• Alarms: Shows the events list.
• Help: Shows the HMI help.
• Logout: Logs you out of the window.

Predefined user account4.2.

HMI has a predefined user account with administrator rights.

• User name: admin
• Password: adminadmin

When you log in for the first time as an administrator, you have to change the password
before you can proceed using HMI. If you forget the new password, restore the factory
settings with the Management tool in CET. After the factory settings have been restored,
you can only log in with the predefined administrator password mentioned above.

User management4.3.

General about managing users4.3.1.

COM605 has the following user levels:
• Viewer = Only allowed to view
• Operator = Authorized to make operations
• Engineer = Allowed to change IED parameters, but no operation rights
• Administrator = Full access
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The administrator can add users and define access rights with the User Management
tool.

The user levels of the selected user are displayed in the User Information view and they
can be modified by the administrator.

The purpose of the user groups is mainly to provide customized user interfaces for dif-
ferent users.

AdministratorsEngineersOperatorsViewersFunctionality

XXXXSLD

XviewXviewControl Dialogs

XXXXEvent list

XviewXviewAlarm list

X*1*1*1User manage-
ment

XXviewviewPST

XXXviewDisturbance
recording

XXXviewSystem supervi-
sion

*1: Can change own password.

view: view-only.

Adding new users4.3.2.

The administrator can add users in the Add User window.

To add a new user:
1. Click on the Users tab on the left.
2. Select Add User.
3. Type in a new user name. The length of the user name can be 1 - 99 characters and

it can only contain characters a - z and 0 - 9.
4. Type in a password and confirm it. The length of the password can be 9 - 99 charac-

ters and it can only contain characters a - z and 0 - 9.
5. Select a user group from the drop-down menu.
6. Click Apply to save the user information.

Modifying user properties4.3.3.

The administrator can modify user information by using the tool bar on top of the User
Information view.
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To remove a user:
1. Click on the Users tab on the left.
2. Select the user you want to remove.
3. Click Remove User and confirm by clicking OK.

To change a user's user group:
1. Click on the Users tab on the left.
2. Select the user whose user group you want to change.
3. Click Change User Group.
4. In the Change User's Group view, select a new group from the drop-down menu.
5. Click Apply.

Changing user's password4.3.4.

To change the password (administrator):
1. Click on the Users tab on the left.
2. Select the user whose password you want to change.
3. Click Change password.
4. Type in a new password and confirm it.
5. Click Apply.

To change your own password:
1. Click on the Settings tab on the left.
2. Click Change password.
3. Type in the old password.
4. Type in a new password and confirm it.
5. Click Apply.

Connecting HMI to the COM600 computer4.4.

To connect HMI to the COM600 computer:
1. Open Internet Explorer.
2. Type in the IP address of the COM600 computer.
3. Accept the certificate.
4. A login window opens. Type in the password and log in.

Substation and communication structures4.5.

Substation structure4.5.1.

You can open the substation view of HMI by clicking on the Substation tab on the left.
The substation structure displays the substation and voltage level objects, bays and IEDs,
and their functions.
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You can see the status of the IEDs in the substation structure. If there is a problem in
communication, there is a red cross next to the IED.

substation_view.jpg

Figure 4.5.1-1 The substation view to HMI

Alarm and event information

By clicking on the voltage level and bay objects, you can access their specific alarm
lists. To look at a list of events, click on View Events above the Persisting Alarms list.

IED information

By clicking on the IED objects you can view their communication status and information
on diagnostic counters. Below each IED in the substation structure you can click on
Disturbances, Parameters or Measurements to access the corresponding data.

It depends on the IED configuration, whether Disturbances,
Parameters or Measurements are shown in the substation
structure.
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Communication structure4.5.2.

You can open the communication view of HMI by clicking on the Communication tab
on the left. The communication structure is displayed in the window on the left. In the
communication structure you can see the OPC Server, communication channel objects
and the IEDs.

You can see the status of the IEDs in the communication structure. If there is a problem
in communication, there is a red cross next to the IED.

communication_view.jpg

Figure 4.5.2-1 The communication view to HMI

Device and diagnostics information

By clicking on the computer name at the top of the structure, you can see its device
information, such as the hardware and software versions, in the window on the right side
of the tree. By clicking on the OPC Server object name, corresponding device information
is displayed on the right. You can view device diagnostics information of the whole
subnetwork by clicking on the subnetwork object. To see the communication status or
diagnostic counter information of individual devices, click on the IED objects.
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Single Line Diagram4.6.

General about Single Line Diagram4.6.1.

A Single Line Diagram (SLD) is a graphical user interface presenting process objects
(primary devices) of the substation as graphical symbols. HMI updates the SLD and the
substation and communication structures at regular intervals. A sample SLD is shown
in Figure 4.6.1-1

SLD_example.png

Figure 4.6.1-1 An example of the Single Line Diagram

For an explanation of the Single Line Diagram symbols, see Appendix 1 , Single Line
Diagram symbols.

Switch Device Control4.6.2.

Switches (circuit breakers, disconnectors) can be operated using the Switch Device
Control dialog.

Only operators and administrators are allowed to control the
switches.
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The station and bay local/remote switch must be in a position which allows it to be
controlled with HMI. The target switch device must also support the operation and it
must be configured properly.

To control a switch device (for example circuit breaker), click the object in the single
line diagram. The Switch device control dialog opens.

The Switch state tab displays information on the substation, voltage level and bay under
operation and the object name of the switch device. Also status information for example
on the interlockings and selection state of the object are displayed.

To control a switch:
1. Select the control direction by clicking Open or Close.
2. Click Operate to activate the selection or Cancel to cancel the operation. Note that

some of the buttons may be disabled depending on the state of the switch.

It is possible to perform a forced cancel operation. This is necessary for example if HMI
is accidentally closed after you have activated a selection. Normally the object would
stay in the selected position until timeout, and the object must be released if any operations
have to be performed before timeout. To perform a forced operation, select the Forced
operation tab of the Switch device control dialog and click Cancel.

To add, edit or delete web links, select the Web links tab and click Edit.

To close the Switch device control dialog, click Exit.
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switch_control.bmp

Figure 4.6.2-1 Switch Device Control dialog

Tap Changer4.6.3.

Clicking a power transformer with tap changer opens a control dialog. In the dialog you
can monitor the voltage and the current tap changer position.
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tap_changer_control.bmp

Figure 4.6.3-1 Tap Changer Control dialog

Depending the device and the configuration, you can manually lower or raise the relative
position of the tap changer or assign a specific position by entering a numeric value.

You must have the required user permissions to perform these
changes, and local/remote switch must allow the operation.
The tap changer must also be in manual operating mode.

The  Operation mode tab shows the auto/manual and single/parallel operation modes
of the tap changer. You can change the modes of the tap if you have the required user
permissions. The operation modes must be supported by the IED support and allowed
by the local/remote. If they are not, the options are not available in the dialog.
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tap_changer_mode.bmp

Figure 4.6.3-2 Tap Changer Mode dialog

Busbar coloring4.6.4.

Busbar coloring can be used to indicate the status of busbar sections in several different
ways. It can indicate which busbar sections are powered, unpowered or in certain other
states, or which voltage level each busbar section has, see Figure 4.6.4-1. Alternatively,
each voltage source or voltage source type can have a color that is used for sections they
are connected to. Busbar coloring can also be used to indicate if two or more voltage
sources form a loop.
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busbar_coloring_modes.jpg

Figure 4.6.4-1 Busbar coloring drop-down menu

Busbar coloring modes

Busbar coloring modes can be selected from the drop-down menu on the top of the Single
Line Diagram View. There are four modes of busbar coloring:

1. No busbar coloring. All sections are displayed in a default color.
2. Powered/Unpowered based busbar coloring. One color is used for all powered

sections.
3. Voltage level based busbar coloring. Different voltage levels have different colors.
4. Voltage-source based busbar coloring. The coloring of powered sections depends

on the voltage source.

Alarms4.7.

General about alarms4.7.1.

The Alarm List displays a summary of the present alarm situation of the supervised
process. Each alarm is presented as an alarm text line, which describes the cause of the
alarm in the process. The alarm text line includes date, time, bay, device, object text,
state and status.

The blinking symbol in the upper right corner of HMI indicates that there are unacknow-
ledged alarms in the substation. There is also an audio alarm, if it has been enabled on
workstation. By clicking the symbol, the Alarm view opens. When all alarms have been
acknowledged, the alarm indicator disappears and the audio alarm stops.
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Monitoring and handling alarms4.7.2.

To monitor and handle alarms in the substation, click Alarms in the menu bar at the top
of the screen. To view the alarms concerning a specific bay, click on the appropriate
object in the substation tree.

You can also filter the alarms concerning a specific voltage level or bay with the Filter
function.

In the Persisting alarms list you can see active alarms. The Fleeting alarms list displays
a list of inactive unacknowledged alarms. The alarm list is continuously updated to
present the actual state of the alarm signals.

To view the event list, click View events.

alarms.png

Figure 4.7.2-1 An example view of alarms

Acknowledging alarms4.7.3.

Click Ack to indicate that you have registered and identified the alarm. Acknowledging
an alarm does not remove the alarm, but changes the alarm state. An acknowledged
alarm is displayed in blue in the Persisting alarms list. Inactive alarms are displayed in
the Fleeting alarms list.

To acknowledge alarms:
1. Select the check box of the alarms you want to acknowledge in the Alarms list.
2. Click Ack on the menu bar.
3. To acknowledge all alarms at the same time, click Ack all.

Filtering alarms4.7.4.

Filters can be used when you want to display only specific information.
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To filter alarms:
1. Click Filter in the toolbar of the Alarms view. A window displaying the substation

structure opens.
2. Click on the object whose alarms you want to view. Now the Alarms list displays

only the alarms of the object that was selected, and the objects below it.

HMI_filtering_alarms.jpg

Figure 4.7.4-1 An example view of filtering alarms

Events4.8.

General about events4.8.1.

With the Event List you can monitor the information about events that have occurred in
the system. Only a certain number of events is visible, and the number of visible events
can be configured in the Communication Engineering Tool. You can also receive
information about activities carried out by other users, operations of objects, acknow-
ledging of alarms, logging in, and so on. The Events list includes the following inform-
ation: date, time, bay, device, object text and event.

Monitoring and handling events4.8.2.

You can monitor the events of the substation by clicking Events in the command bar at
the top of the screen. To monitor the events of specific bays, click on the appropriate
object in the substation tree. The event list is updated automatically.
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You can filter the events concerning a specific voltage level or bay with the Filter
function.

You can stop the updating of the event list by clicking Freeze. To resume the flow of
events, click Continue. You can save events locally on your computer by clicking Save.
The list is saved in .csv format and can be opened in MS Excel.

To view the alarms list, click View alarms.

HMI_events.png

Figure 4.8.2-1 An example view of events

Filtering events4.8.3.

Filters can be used when you want to display only specific information.

To filter events:
1. Click Filter in the toolbar of the Events view. A window displaying the substation

structure opens.
2. Click on the object whose events you want to view. Now the Events list displays

only the events of the object that was selected, and the objects below it.
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HMI_filtering_alarms.png

Figure 4.8.3-1 An example view of filtering events

Disturbance data upload4.9.

Disturbance recordings4.9.1.

Most of the IEDs are equipped with a Disturbance recording function that locally stores
the values of currents, voltages, frequencies and binary signals and so on in a disturbance
file before, during and after a protection event. These disturbance files can be copied to
the COM600 computer automatically, if the function has been configured in CET.

You can see the list of disturbance recordings by clicking on Disturbances below the
desired IED in the substation structure.

disturbances.png

Figure 4.9.1-1 Example view of disturbance recordings

31

COM615 3.2COM600 Station Automation Series1MRS756123

Operator's Guide



The disturbance recordings list shows you the description, date and time of the disturb-
ance. When you want to save the list locally on your computer, select it and download
it by clicking Save. The list is saved in .csv format and can be opened in MS Excel. You
can also delete disturbance recordings from the COM600 computer by clicking Delete.

Parameter setting4.10.

Changing parameters4.10.1.

You can view parameter information by clicking on Parameters below the desired IED
in the substation structure, if this functionality is supported by the IED. In this view you
can also change parameter settings.

Click the  icon next to the parameter to open the corresponding help text for each
parameter.

parameters2.png

Figure 4.10.1-1 An example of the Parameter Setting view

To change parameter settings:
1. Click Enable Write on the top of the Parameter Setting view.
2. Select a new value from the drop down menu or type in a value in the New Value

field. To apply changes, click Write to IED.
If the new values are accepted, the background of the modified parameters turns
green. If the new values are incorrect, a message "Some settings are not in correct
range" is displayed and the background of the modified parameters turns red. Type
in values that are in the correct value range.

3. To manually update the values, click Refresh Values.
4. After you have made all necessary changes, click Disable Write.

If the IED has been configured with a store option, a store dialog will appear. In the
dialog you can store the parameter changes permanently to the IED non volatile
memory. If you click OK, the parameter changes are stored permanently. If you
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click Cancel, the parameter changes are only saved temporarily, and they will be
lost after next reset of the IED.

When writing parameters to REF 542plus:

• Parameter value changes are not activated immediately
when you click Write to IED, but only after you have
stored the values permanently by clicking OK or tempor-
arily by clicking Cancel in the store dialog. The store
dialog appears when you click Disable Write or when
you close the parameter setting tool while a write session
is open.

• Parameter Set selection will restore the old value until
the new value has been stored permanently or temporarily.

IEC 61850 setting groups and parameters

Certain IEC 61850 parameters are assigned to setting groups. These parameters can have
different values in different groups. Parameters belonging to setting group have # char-
acter as a prefix in the name. You can view the parameters of each group by selecting
the the Setting group number from the drop down menu. The currently active Setting
group number in the IED is indicated with an asterix (*) in the Setting Group selection
drop down list.

To change the parameter values in a setting group:

1. Select the Setting Group to be edited
2. Click Enable Write on the top of the Parameter Setting view.
3. Enter the new values for the parameters
4. Write the changed parameter values to IED by clicking Write to IED.
5. Store the parameter changes permanently to IED by clicking disable write or closing

the tool. Pop-up dialog will prompt for store or cancel.

The active setting group in the IED is changed with Active Setting Group parameter. To
change the parameter follow the steps 2 to 5 above.
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parameters3.png

Figure 4.10.1-2 Selecting a parameter group

Measurements4.11.

Viewing measurements4.11.1.

To view measurement information, click on Measurements below the desired IED in
the substation structure. HMI updates the measurement information automatically.

measurements.png

Figure 4.11.1-1 An example view of measurements
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Appendix 1

Single Line Diagram symbols

Table A1-1 Single Line Diagram symbols
RemarksIEC represent-

ation
ANSI repres-
entation

Description

Annotation

Alarm indicator in a branch of
the substation. Use at any level
in the structure to indicate
alarms generally, or a specific
alarm. The indicator is not vis-
ible in the web view when there
are no active alarms.

Alarm Indicator

Binary indicator (on/off, auto-
matic/manual, X/not-X, etc.). It
can also be used to send a
command.

Two State Switch

Hyperlink to external informa-
tion source, such as a web
page or a local file on COM600.

Files should be stored under
C:\Program Files\COM610 GW
SW\WebHMI\UserDocs\. The
total size of the files should not
exceed 100 MB. Link syntax for
local files is: http://<COM600
IP address>/HMI/User-
Docs/<filename>

Launch Web Page

Use to send a single command
to one target.

Push Button

Use to launch an application
external to COM600

Application Launch

Measurement Text Box

ViaPoint

Connectivity Node
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Circuit breaker – Intermediate
position

Circuit breaker – Open position

Circuit breaker – Closed posi-
tion

Circuit breaker – Bad (faulty)
position

Disconnector – Intermediate
position

Disconnector – Open position

Disconnector – Closed position

Disconnector – Bad (faulty)
position

Truck – Intermediate position

Truck – Open position

Truck – Closed position

Truck – Bad (faulty) position

Use IEC rep-
resentation

Load breaker – Intermediate
position

Use IEC rep-
resentation

Load breaker – Open position

Use IEC rep-
resentation

Load breaker – Closed position

Use IEC rep-
resentation

Load breaker – Bad (faulty)
position

Use IEC rep-
resentation

Contactor – Intermediate posi-
tion

Use IEC rep-
resentation

Contactor – Open position
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Use IEC rep-
resentation

Contactor – Closed position

Use IEC rep-
resentation

Contactor – Bad (faulty) posi-
tion

Primary winding: on top. Sec-
ondary winding: below. All
composing elements exist as
individual symbols.

Power Transformer with two
Windings and no Tap Changer

Primary winding: on top. Sec-
ondary winding: below. All
composing elements exist as
individual symbols.

Power Transformer with two
Windings and Tap Changer

Primary winding: on top. Sec-
ondary winding: below left.
Tertiary winding: below right.
All composing elements exist
as individual symbols.

Power Transformer with three
Windings and no Tap Changer

Primary winding: on top. Sec-
ondary winding: below left.
Tertiary winding: below right.
All composing elements exist
as individual symbols.

Power Transformer with three
Windings and Tap Changer

Voltage Transformer (measure-
ment)

Current Transformer (measure-
ment)

Capacitor

Reactor

Generator

Motor

Use ANSI rep-
resentation

In-feeder

Use ANSI rep-
resentation

Out-feeder

Use ANSI rep-
resentation

Earth symbol
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Use ANSI rep-
resentation

Bay Switch Indicator

Use ANSI rep-
resentation

Station Switch Indicator
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